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Introduction
Thank you for choosing Gravis Firebird 2. The 13 programmable buttons and
8-way hat switch give you direct access to virtually all of a game’s command
functions. Put your keyboard away! The Firebird 2 software allows you to
assign different functions for button press and release. Define any button for
turbo control, even if your game doesn’t already support turbo. Set up a single
button to perform a series of commands.

The T-grip throttle gives you full control for flight simulators and games that
support joystick throttle control. And the flexible button programming system
even accommodates most simulators that support throttle control only through
keyboard commands. The trim adjuster gives you trim control even in games
that don’t directly support elevator trim adjustment.

Firebird 2 controls your games and simulators without requiring direct support
by software, so Firebird 2 works with all IBM® PC-compatible action games
and simulators that support a joystick. Firebird 2 uses your computer’s dual-
joystick game port to provide analog joystick control of your flight simulators
and games. For added flexibility, Firebird 2 also works with your keyboard to
let you assign all your games’ keyboard controls to any of the joystick's
buttons.
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The DOS-based Firebird Control Console (FCC) software lets you design and
save an unlimited number of custom control plans, or sets, for individual
games and flight programs. You can create game sets by assigning keyboard
or joystick button commands to the joystick's buttons, choosing control prefer-
ences like Turbo rate, and enabling or disabling throttle and elevator trim.

Once you configure Firebird 2, it keeps its settings in memory, even when you
turn off your computer, so you won’t need to reconfigure Firebird 2 unless you
want to use a different control set.

Firebird 2 also includes a program (FBD.EXE) that allows you configure the
joystick directly from the DOS prompt for fast game setup. You can use this
program in batch files to set up Firebird 2 with a game’s unique control
settings automatically every time you start the game.

Control sets for many popular games and simulators are included with your
joystick's software. You can configure Firebird 2 and start playing your favorite
game within minutes. You’ll find these ready-made game sets in the directory
where you installed your joystick's software—they’re the files with the .FBD
extension. Use these settings if you want to begin using Firebird 2 immediately.
Modify them if you like, or use them as examples when you create custom sets
of your own.

...Introduction, cont’d.
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What to Read
For most users, the best way to get started with Firebird 2 is to follow the
installation instructions in this chapter, then complete the tutorial in Chapter 2.

For advanced users, the Quick Install guide may be sufficient.

For detailed instructions, refer to the Firebird Control Console’s Help menu, or
continue reading this manual. The Control Console’s Help system also includes
a glossary.

If you run into problems, see the Control Console’s Help menu or the Trouble-
shooting and Technical Support  chapters in this manual.
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What You’ll Need
• IBM PC or compatible, 286 or better

• DOS 3.3 or greater

• IBM PC-compatible game port

• AT-compatible or PS/2-style keyboard port

• VGA-compatible video monitor and VGA video adapter

• Double-speed or better CD-ROM drive

We Recommend:
• SVGA video monitor and adapter card

• Microsoft®-compatible mouse

• Speed-compensating game port

• A fully functional 4-axis, 4-button game port is required to use the throttle.
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Connecting Firebird 2

Keyboard Port

Keyboard Socket *
(to Keyboard)

D-15 Joystick Connector

Game Port

Keyboard Plug*
(to Keyboard port)

* Do not plug the Y-cable’s keyboard plug into its own socket. 
One side of each connector (plug and socket) will not be used.

Figure 1-1. Connecting Firebird 2

1. Turn off your computer.

Connecting Firebird 2 to your computer while it is on could damage the
joystick or your computer. Never plug or unplug any connector while your
computer is on.
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The joystick's Y-cable has three connectors: one connects to the game port,
one to the keyboard port, and one to the keyboard (see Figure 1-1). The
keyboard port plug and keyboard socket each have two connectors to
accommodate computers with either 5-pin or 6-pin connectors.

2. Plug the joystick's 15-pin (D-15) connector into your computer’s joystick
port. Screw the D-15 connector securely onto the game port connector.

Do not stretch cables or twist connectors when you connect Firebird 2. Line
up the connectors before you insert them.

3. Disconnect your keyboard from the computer.

4. Plug the joystick's keyboard plug (male) into your computer’s keyboard
port. Use either the 5-pin DIN or the 6-pin mini DIN, whichever fits. The
other end of the male plug is not used; don’t plug anything into it.

If the joystick's keyboard cable is not long enough, you can lengthen it
with an AT or PS/2 keyboard extension cable.

5. Plug your keyboard into the joystick's keyboard socket (female). The other
end of the female socket is not used; don’t plug anything into it.

...Connecting Firebird 2, cont’d.

D-15 Joystick Connector

Game Port

Keyboard Port

Keyboard Plug*
(to Keyboard port)

Keyboard Socket *
(to Keyboard)

* Do not
One side
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Do not plug the cable’s keyboard plug into its own keyboard socket. The cable
has both 5-pin and 6-pin keyboard plugs and sockets to accommodate differ-
ent types of keyboard ports, so one end of each of the joystick’s keyboard
connectors will not be used.

...Connecting Firebird 2, cont’d.
Do not plug the cable's keyboard plug into its own keyboard socket. The
cable has both 5-pin and 6-pin keyboard plugs and sockets to
accomodate different types of keyboard ports, so one end of each of the
joystick's keyboard connectors will not be used.

6. Turn on your computer.
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Default Settings
By default, Firebird 2 is set to be compatible with the Gravis Thunderbird 2/
CH FLIGHTSTICK® PRO:

• Standard, four-button support(using the four handle buttons)

• FLIGHTSTICK PRO-compatible hat switch

• Throttle enabled

• Trim disabled

The remaining buttons do nothing until you configure Firebird 2 with a set
using the Firebird Control Console (FCC.EXE) or FBD.EXE software.
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Registration
Please fill out and mail the enclosed registration card.

Gravis may update the product’s software and hardware components from
time to time. We can only tell you about such changes, and notify you of
special offers, if you complete and mail your registration card.
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Activating the Firebird Control Console
At the DOS prompt, type: FCC <Enter> or double-click the Firebird 2 icon
in Windows.

Note: As long as you do not remove the C:\GRAVIS\PCFB2 entry from your PATH
statement, you can activate FCC from any drive and directory.
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Where to Go for Help
On-line help is available at all times within the Firebird Control Console. Select
Contents... from the Help menu. The Help system is easy to use. Instructions for
accessing and using the Help System are included in Chapter 3, Firebird
Control Console. You will also find instructions on Firebird 2 hardware diag-
nostic tests in Chapter 3.

See Chapter 7 for troubleshooting help and Chapter 8 for information on
contacting Gravis Technical Support.
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Introduction
This tutorial will teach you how to load or create a control set and configure
Firebird 2 to use it with a game.

Before you begin the tutorial, you should connect Firebird 2 and install its
software.

When you’ve completed this tutorial, you should be able to:

• Activate the Firebird Control Console and load a preconfigured set or
create a new one.

• Assign keyboard and joystick command functions to buttons.

• Configure Firebird 2 – from the Control Console and from the DOS
prompt.
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Activating the Firebird Control Console
At the DOS prompt, type: FCC <Enter> or double-click the Firebird 2 icon
in Windows.

Note: As long as you do not remove the C:\GRAVIS\PCFB2 entry
from your PATH statement, you can activate FCC from any drive
and directory.

The Control Console main display appears, with an image of the Firebird 2.

Firebird Control Console Main Display
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Using a Preconfigured Set
If one of the control sets included with your Firebird 2 software was designed
for your favorite game, you can configure Firebird 2 to use those settings, and
start your game right away!

1. Choose Open... from the File Menu.

2. Choose a set from the list of available sets (files with the .FBD extension).

3. Select Configure Firebird from the File menu to apply the control settings
in the set you selected to your joystick's buttons.

4. Choose Print from the File menu if you want to print a list of the control
settings in the set that you selected.

Or read the section “Create Template” in Chapter 3 to learn how to create
a PCX reference template for your joystick's control settings.

If you don’t see a set for the game you want to play, continue with this tutorial
to learn how to create your own set with the settings that work best for you.
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Mouse and Keyboard Control
The Control Console is designed to be used with a mouse. If you prefer to use
the keyboard, use the following keys:
To select a menu option: <Alt >+ underlined letter
To choose OK:  <Enter> (if keystroke entries are ended)
To choose Cancel: <Esc> (if keystroke entries are ended)
To start a keystroke entry: <Ins> or <Enter> with the cursor in the

entry field
To end a keystroke string: <Esc-F1>
To move forward one entry field: <Tab>
To move back one entry field: <Shift-Tab>
Select a radio button: <Space bar> to select
Move sliders (Preferences dialog) Left and right arrow keys
Function List: Add <Ins>
   Edit <Enter>
   Get FBD <Alt-Ins>
   Delete <Del>
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Creating a New Set
In this tutorial, you’ll learn how to create a new set, assign button functions,
and configure Firebird 2 to use the settings. To create a new set:

Select New from the File menu.

A new [Untitled] set file opens. By default, a new set includes only the minimum
settings for Gravis Thunderbird 2/CH FLIGHTSTICK® PRO compatibility:

4-button support (using the 4 handle triggers)
FLIGHTSTICK PRO-compatible hat switch
Throttle control is enabled; Trim is disabled (in the Edit/Preferences window)

The remaining buttons are unconfigured—that is, they have no functions
assigned to them.
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Saving a File
Use the Save and Save As... options in the File menu to save the sets that you
create or modify in the Control Console.

1. From the File menu, choose Save.

2. In the Filename field, type: TUTORIAL.

3. Select OK to save the file ‘TUTORIAL’ into the default C:\GRAVIS\PCFB2
directory. The file is saved with a .FBD extension (TUTORIAL.FBD).

If you choose Save again, the file is saved automatically with the same name.
To save the file with a new name, choose Save As....
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Opening a Button Assignment window
1. Move your mouse over the image of Firebird 2.

Notice that the selection arrow becomes a pointing finger when you move
it over top of one of the joystick's buttons.

2. Hold down the left mouse button as you move the mouse pointer over a
button.

Notice that the button turns yellow.

If you continue to hold the mouse button down while you move away from
that button, you’ll notice that the mouse pointer begins to drag a copy of
the selected button with a © attached to it. This lets you copy a button’s
control settings to another button or to the Function List. You’ll learn more
about the button copy, move, and swap functions later.

3. With the mouse pointer over the button you selected initially, release the
mouse button, and a button assignment window opens.

(You can also right-click on the button and choose Edit... from the pop-up
menu to open the button assignment window.)

4. Select Cancel to return to the main Control Console screen.
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Assigning Button Functions
Try programming a button:

1. From the Base menu at the top of the screen, select Button 1.

A button assignment window opens.

   Base Button 1 Setting
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...Assigning Button Functions, cont’d.

When you open the button assignment window, the cursor is positioned in the
Keystrokes–Button Press field.

2. Click on the gray edit bar to begin the entry.

3. Press and hold the <ALT> key, then press <H>. Click on the gray edit bar
(which now says “Done”) to end the entry.

4. Click the “<End of keystroke string>“ line in the Button Release entry box.

5. Click on the gray edit bar, then press the <C> key. Select OK.

Pressing this button while playing a game would have the same effect as
pressing <ALT-H> on the keyboard, then <C> when you release the joystick's
button.
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Using the Function List
1. If the Function List isn’t already displayed on your screen, select Show

Function List from the Options menu to display it.

    Function List
The Function List lets you enter the button commands for a game set
quickly, then decide later which functions should be assigned to which
button. You can press the Get FBD button to display a copy of the functions
of each joystick button in the Function List. You can create as many button
functions as you like; they don’t have to be tied to a specific button. And
you can drag functions from the Function List to any button.

Note: The Function List can display multiple copies of an identical
function, so if you press Get FBD twice, you will see two copies of
each button function in the Function List.

2. Click the Add button at the top of the Function List to open a new button
assignment window.
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...Using the Function List, cont’d.
A generic button assignment window opens. This box is not tied to a specific
button on Firebird 2.

3. Press <Ins> or click on the gray edit bar to begin entering keystrokes.

    Add Function Window

Edit
bar
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4. Press the <Tab> key, then <Enter>.

5. Click the Step radio button.

6. Click in the Comment box, and type the name “TUTOR2.” Then select Add
to add the function to the Function List.

7. Click Close to close the button assignment window.

The first time you pressed a button configured this way while playing a
game it would have the same effect as pressing the <Tab> key on the
keyboard. If you pressed the button a second time, it would have the same
effect as pressing the <Enter> key. (The third time you pressed it, it would
go back to <Tab>, and so on.) You’ll use these buttons later.

The name “TUTOR2” should now appear in the Function List.

8. Drag the TUTOR2 function from the Button Functions list to the Plus button
on your joystick. You’ll see a “circle-C” symbol attached to an image of a
button in place of your mouse pointer.

Release the mouse button when the image changes to an arrow pointing
down at the Plus button.

...Using the Function List, cont’d.
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...Using the Function List, cont’d.
If you click on the Plus button to open the assignment window, you’ll see that
the <Tab> and <Enter> keys are now assigned to that button.
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Copying, Moving, and Swapping Button Functions
The Control Console also allows you to copy or move functions from one
button to another, or swap functions between buttons, the same way you just
copied a function from the Function List.

To move a button’s function to another button:

Hold down the <Shift> key while you drag the image of the first button to
the second button (you’ll see a circle-M symbol attached to the button
image while you’re dragging it).

To swap functions between two buttons:

Hold down the <Ctrl> key while you drag the button image (a circle-S
symbol appears with the button image).

Please read Chapter 3 for more detailed instructions.
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Printing Control Settings
Print the control settings and descriptions for your new set. You must have a
printer connected to the computer’s LPT1 port to use this option.

Select Print from the File menu.

You can also use the File/Create Template... option to view a PCX reference
chart of Firebird 2 with your control settings for each button labeled. The
Create Template dialog lets you save the file for later printing. See Chapter 3
or the Control Console’s Help system for instructions.



Chapter Topics

Book Topics

Firebird 2 User's Guide

Chapter 2 – Tutorial

Configuring Firebird 2
To use a game control set, you have to save the set and configure Firebird 2.
Your joystick WILL NOT work properly if you skip this step.

1. From the File menu, select Save.

2. From the File menu, select Configure Firebird.

This loads the settings in the current game set (in this case, TUTORIAL.FBD) into
the joystick's memory.
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Using Firebird 2
Now you can try your new button settings.

1. Press Base Button 1 on Firebird 2 (the button nearest the throttle).

You assigned the function <Alt-H> to this button, so when you press it, it
should open the Help menu. When you release the button, since you
assigned <C> to the button release, it should select Contents and open the
Help file’s Table of Contents.

2. Press the Plus button on Firebird 2 once.

You assigned the function <Tab> as the first step for this button, so pressing
it once should move your cursor to the next topic in the Table of Contents.

4. Now press the Plus button again.

Since you assigned <Enter> as the second step for this button, pressing it
should open the selected Help topic.



Chapter Topics

Book Topics

Firebird 2 User's Guide

Chapter 2 – Tutorial

Exiting the Control Console
Close the Help system, if you haven’t already, then choose Exit from the File
menu.

If you haven’t saved your latest changes, the Control Console will prompt you
to save your changes or exit without saving.

After you exit the Firebird Control Console, you’re ready to play a game using
the new control settings. The next time you activate the Control Console, it will
remember the last set opened and reopen it.
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Game Setup and Calibration
When you start a new game, choose Joystick, Regular Joystick, or Enable
Joystick—whatever description the game uses for a regular joystick—in the
game’s Setup. (If you select “CH” mode for the hat switch, select CH
FLIGHTSTICK PRO in the game.)

Remember to run the game’s calibration program. For an explanation of
joystick and software calibration, select Calibration from the Table of Contents
in the Firebird Control Console’s Help system .
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Using the Help Menu
The Help menu provides detailed instructions for using Firebird 2.

Take a look at the Help window:

1. Select Contents... from the Help menu to access the Help system.

The Table of Contents window opens.

The Help window includes simple tools to help you find the information you
need.
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Table of Contents

2. Select Throttle from the Table of Contents.

3. Select the >> button to move to the next page.

4. Use the << button to move back one page.

...Using the Help Menu, cont’d.
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5. Select the Contents... button to return to the Table of Contents.

6. Select the Back button to return to the last page you viewed, even if it is not
in sequence.

Pressing this button now will return you to the page you were viewing
before you pressed the Contents button.

7. Press Exit to return to the Control Console.

...Using the Help Menu, cont’d.
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1. Make sure that the Firebird is connected correctly and operating properly.

2. Use the Firebird Control Console to create a set with the ideal button
commands for each of your games and simulators.

3. Create a template or print a list of the control settings for each set, if you
like, to use for reference when you play your games.

4. Configure the Firebird with a set designed for the game you want to play.

5. Start your game!

Firebird 2 Checklist
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Help Menu

Chapter 3



Chapter Topics

Book Topics

Firebird 2 User's Guide

Chapter 3 – Firebird Control Console

Introduction
Your Firebird 2 software includes two programs you can use to configure your
Firebird 2: the Firebird Control Console (FCC.EXE) and a command-line set-
loading program, FBD.EXE. A third program, Firebird KeyTester
(KEYTEST.EXE), allows you to test your joystick's current settings.

The Control Console is the command center for your Firebird 2. From the
Control Console, you can assign keyboard and joystick button commands to
your joystick's buttons, adjust button settings, and enable or disable throttle
and elevator trim for each of your games. The Control Console saves this
information in files called sets. You can use the Control Console to create as
many custom sets as you need for each of your games.

If you want step-by-step instructions for creating sets, go through the tutorial in
Chapter 2. Use this chapter, and the Control Console’s Help menu, as a
detailed reference for each menu and option in the Firebird Control Console.

To activate the Firebird Control Console:
At the Dos prompt, type: FCC <Enter> or double-click the Firebird 2 icon in
Windows.

Note: As long as you do not remove the C:\GRAVIS\PCFB2 entry from
your PATH statement, you can activate FCC from any drive and direc-
tory.
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The first time you activate the Control Console, it opens an untitled set with only
the default configuration. Once you have opened your first set, each time you
activate the Control Console, it will remember and open the set you opened
last (not necessarily the set your Firebird 2 is using).

    
FCC Main Screen

...Introduction, cont’d.
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Add Function Window

         Add Function Window

You will do all your button programming in the Add Function button assign-
ment window. You can access the Add Function window in several ways:

• Clicking the Add button in the Function List window opens a generic Add
Function window—not tied to any specific button on Firebird 2.

• Clicking the Edit button in the Function List window opens an edit window
for the function currently selected in the list.

• Clicking on a button on the Control Console screen (or right-clicking on the
button and choosing Edit... from the pop-up menu) opens a button assign-
ment window like the Add Function window, but specifically for that
button.

• Selecting a button from the Base or Stick menu also opens a button
assignment window for that specific button.

The Add Function window allows you to define keyboard or joystick button
commands (“functions”).

Button Press: This section of the Add Function window allows you to enter
the key or keys that you want to be executed when you press a button on
Firebird 2.
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... Add Function Window, cont'd.

Button Release: This section allows you to enter a separate key or keys to
be executed when you release the Firebird 2 button. Use this feature to toggle
between two views in a game, change weapons for a short time, etc. Just press
the button to switch views or weapons, and hold down the button until you
want to switch back.

Joystick Button: This section of the Add Function window lets you set up the
Firebird 2 button to act as a joystick button (or buttons). You can assign as
many as four joystick buttons to a single Firebird 2 button.

You CANNOT assign keyboard keys and joystick buttons to a
single button.

Standard, Step, Turbo: These radio buttons allow you to select a control
type for the button.

• A Standard Firebird 2 button works exactly like a keyboard key. If you
assign a single key to a button, the key is executed immediately when you
press the button, then repeats until you release the button.

There is a slight delay between the initial key and the repeat; you can
control the length of this delay, and the rate of repeat (called “typematic
rate”), in the Edit/Preferences dialog.



Chapter Topics

Book Topics

Firebird 2 User's Guide

Chapter 3 – Firebird Control Console

...Add Function Window, cont'd.
Strings of Button Press keys and Button Release keys are executed once when
you press the button and do not repeat if you hold down the button. Standard
joystick buttons act like normal joystick buttons.

• The Turbo setting lets you set a key press string or joystick button to repeat
rapidly and continuously for as long as you continue to press the button.
You can control the rate of the Turbo repeat in the Edit/Preferences dialog.

• Step mode allows you to program multiple game commands that are
always executed in the same order (for instance, commands for raising
and lowering landing gear) into a single Firebird 2 button.

For instance, using the landing gear example, assume that the game’s com-
mands are “R” to raise the gear and “L” to lower it. To program a button to
raise and lower the gear:

1. Enter the keys “R” and “L” into the button’s Button Press box.

2. Click the Step radio button and select OK.

3. Configure Firebird 2 with this set.

The first time you press the button during the game is like pressing the “R” key.
The next time you press the button is like pressing “L.” The third time, “R”
again, and so on. Step mode does not apply to joystick buttons or Button
Release keys, and typematic settings do not apply.
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... Add Function Window, cont'd.
Pacing: Click the Delay On checkbox to increase the delay between keys
in a button press or release string.

Some games may be unable to handle incoming keys fast enough, so they
may miss keys. If Firebird 2 appears to sporadically miss some or all keys
defined for a button, your game may have this problem. Check Delay On,
and in-crease the delay using the Pacing slider in the Edit/Preferences
dialog. (The Pacing slider controls the pacing for every button that has the
Delay On checkbox checked.)

Comment: Click in the Comment box to enter a one-line description of the
button’s settings. This description appears, by default, in the control listing
and reference chart that you can create from the File menu. You may find it
more useful to have a control listing or template labeled with the game
function (e.g., “Button 2: Jump”) rather than the key (e.g., “J”).

To Define a Keystroke Command:
1. Click on the gray edit bar while the “<End of keystroke string>“ line is

selected to begin entering a key or string of keys in the Button Press
box.

2. Enter a key or series of keys.

3. Click on the “<End of keystroke string>“ line or the gray edit bar to end
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...Add Function Window, cont'd.
the keystroke string.

4. If you want to enter a separate keystroke string for button release, click
inside the Button Release field and repeat steps 2–3 for the Button Release.

5. Choose a control type: Standard, Step, or Turbo.

6. If you like, you can click in the Comment box to enter a one-line descrip-
tion of the button function.

7. Select OK or Add when finished, then select another button to configure.
Select Clear at any time to clear your selections and start over.

To Insert a Key:
1. Open the Add Function window for the button (or unassigned function in

the Function List) that you want to change.

2. Click your right mouse button on the key that you want to follow the key
you insert. If you want to insert a key at the end of the string, right-click on
the “<End of keystroke string>“ line. Choose Insert from the pop-up menu
(Figure 3-2).

3. Type the key (or keys) you want to insert.

Inserting a Key
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4. Click on the “<End of keystroke string>“ line to end the keystroke string.

To Delete a Key:

1. Open the Add Function window for the button (or unassigned function in
the Function List) that you want to change.

2. Select the key that you want to delete, then press <Del>.

To Cut or Copy and Paste a Key (or String of Keys):

1. Open the Add Function window for the button (or unassigned function in
the Function List) that you want to change.

2. Click your right mouse button on the key that you want to cut or copy.

To select several keys, left-click and drag to the end of the selection. Right-
click on the selection, then choose Cut or Copy from the pop-up menu.

3. Right-click on the key you want to follow the keys you are pasting in, then
choose Paste from the pop-up menu.

4. Click on the “<End of keystroke string>“ line to end the keystroke string.

... Add Function Window, cont'd.
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...Add Function Window, cont'd.
To Define a Joystick Button Command:

1. Click on one of the joystick button checkboxes.

Joystick Buttons 1 and 2 represent buttons 1 and 2 of Joystick A.
Joystick Buttons 3 and 4 represent buttons 1 and 2 of Joystick B.

2. If you like, you can click in the Comment box to enter a one-line descrip-
tion of the button function.

3. Select OK or Add when finished, then select another button to configure.
Select Clear at any time to clear your selections and start over.
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Function List

          

          Function List

The Function List simplifies the process of entering button functions for a new
game set, and provides an easy method for changing button functions quickly.

The first step in creating a new set for a game is to determine what keys and
joystick buttons are used in the game’s controls. Usually you can find this
information in a quick reference sheet, in the game’s on-screen Help or Setup,
or in the game’s manual.

The Function List allows you to enter these game commands quickly, without
having to decide right away which button to use for each command. Just use
the Add button on the Function List window to enter each of the game com-
mands. The Add Function window that opens when you press the Add button
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...Function List, cont'd.
is not tied to a specific button; after you’ve entered the game’s commands, you
can drag each function in the Function List to any button on the joystick.

You can also right-click inside the Function List to open a pop-up menu that
allows you to choose editing options.

Get FBD

Click the Get FBD button to copy the functions of each of your buttons into the
Function List.

Add

Click the Add button to define a new button function. Pressing Add opens a
generic Add Function window that is not tied to any specific button.

Read the previous section, The Add Function Window, for instructions on
assigning button functions.

Edit

Click the Edit button to change the settings for the highlighted function in the
Function List.
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...Function List, cont'd.
Delete
Use the Delete button to delete the highlighted function from the Function List.
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Copying, Moving and Swapping Button Functions
The Firebird Control Console lets you click and drag to copy or move button
functions from one button to another or from the Function List to a button. You
can even swap functions between two buttons.

1. Click your right mouse button on a button and choose Copy, Move, or
Swap from the pop-up menu.

As you move your mouse pointer away from the first button, you’ll notice a
circle-C, -M, or -S symbol attached to an image of the button.

2. Click on another button.

If you chose Copy, the function of the first button is copied to the second; the
first remains the same. If you chose Move, the first button’s function is copied to
the second button, and the first button is now unconfigured. If you chose Swap,
the first button’s function is now applied to the second button, and the second
button’s to the first.

Shortcut: To copy a button function, left-click and drag from one button to
another. Release the mouse button to apply the setting. To move a button
function, do the same thing, but hold down the <Shift> key while you release
the mouse button. To swap button functions between two buttons, hold down
the <Ctrl> key while you release the mouse button.
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File Menu
New

Creates a new, untitled set.

Open...

Opens an existing set.

1. Type the full path and filename for the file you want to open. Or select a
drive in the Drives box, and choose from the list of Firebird 2 (.FBD) files.

2. Select OK.

Save

Saves a set.

1. Assign a valid DOS filename. All Firebird 2 sets are identified with an
.FBD extension and, by default, are saved into the C:\GRAVIS\PCFB2
directory.

2. Select OK.

Save As...

Saves a modified set with a new name, preserving the original file.
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...File Menu cont'd.
1. Assign a new, valid DOS filename.

2. Select OK.

Delete...

Deletes a set.

1. Type the full path and filename for the file you want to delete. Or select a
drive in the Drives box, and choose from the list of Firebird 2 (.FBD) files.

2. Select OK.Create Template...

Configure Firebird

Loads the settings in the open set into the joystick’s memory. The next time you
use the Firebird 2 control buttons, they will perform the functions assigned to
them in that set.

Print

Prints a list of control settings and descriptions for the open set. The Print option
requires a printer connected to the computer’s LPT1 port. This is a text printout,
not a graphical chart.
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...File Menu, cont'd.
Create Template...
Creates a diagram of the Firebird 2 with its button functions labeled. When
you select this option, FCC displays the diagram on screen and lets you specify
what text you want for labels. See the illustration on the next page.

Auto: Labels the template with the Comment for each button, if there is one,
or with the button’s Button Press or Joystick Button function. If you program
buttons with long keystroke strings, you may want to enter Comments for the
buttons to keep the template cleaner and more usable.

Comment: Labels the template with the comments you’ve typed in the Add
Function windows’ Comment fields.

Press String: Labels the template with the keys you’ve programmed for each
button’s Button Press.

Release String: Labels the template with the keys you’ve programmed for
each button’s Button Release.

To save this template, press Save. The file is saved with the same name as the
set and a .PCX extension. To print, you must have a printer that can print
graphics and software (like the Paint program that comes with Windows ™ )
that can print .PCX files. To cancel the template without saving it, click Cancel.
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...File Menu, cont'd.
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...File Menu, cont'd.
Exit

Exits the program. If you haven’t saved the current set, you will have the option
to save and exit, exit without saving, or cancel and return to the Firebird
Control Console.
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Edit Menu
Title...
Activates the Title field at the bottom of the Firebird Control Console main
display. Choose this menu option, or click inside the Title field with your mouse
to activate it.

The Title field lets you give your sets a descriptive title. You can use this field to
identify the game that the set is designed for, or to note other sets for the same
game. For example, if you create separate sets for different aircraft in the
same simulation, the Title field lets you give each set a descriptive title. This title
appears alongside the set name when you select a set file in the File/Open...
and File/Delete... windows.

Notes...
Opens a large text window where you can type and save detailed notes about
a set. Clicking on the notebook icon in the lower left corner of the Firebird
Control Console main display also opens the Notes window.

    

          Edit Notes Icon
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...Edit Menu Cont'd.
Preferences...
Opens the Preferences dialog box, where you can choose settings specific to
the open set. You can set different Preference settings for each set if you like.

      

Preferences Dialogue

Turbo Settings

Turbo Rate Slider: Drag the slider left or right to set the turbo repeat rate
for buttons you set as Turbo key press strings or joystick buttons. Left slows the
rate; right speeds it. This rate applies only to buttons set for Turbo.
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Typematic Settings

Each time you press a button configured with a single key in “Standard”
mode, Firebird 2 sends that key to the game, delays, then repeats the key for
as long as you hold down the button. The key repeat and delay are controlled
by your Typematic settings.

Typematic Delay: When you press a “Standard” mode button that is
assigned a single key, Firebird 2 executes the key once, delays, then repeats
the key. This option lets you set the length of delay before the key begins to
repeat.

Typematic Rate slider: Drag the slider left or right to set the Typematic
repeat rate for buttons you program as a Standard key. Left slows the repeat
rate; right speeds it.

The Typematic settings do not apply to buttons configured as Step or Turbo
keystroke buttons or joystick buttons or to keystroke strings.

Enable Throttle Control

Check this box to enable (turn on) the throttle on Firebird 2. The throttle is the
rightmost of the two wheels at the top of the joystick’s base—the one with the T-
handle. The throttle works with any game that supports joystick (analog)

...Edit Menu Cont'd.
If you select the Step or
Turbo option for a button,
typematic settings do not
apply. "Step" keys do not
repeat, and Turbo Rate is
controlled by the Turbo
slider.
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...Edit Menu Cont'd.
throttle control. To use the throttle, push it forward (up) to increase speed; pull
it back (down) to reduce speed.

Some programs, such as Microsoft ® Flight Simulator ™ , require you to set
the throttle to its “off” position (all the way back) each time you start a new
scenario.

If your game or simulator supports only keyboard throttle control, uncheck this
box to disable the throttle, and examine the game’s commands for “increase
and decrease throttle.” Simulators that don’t support joystick throttle control
commonly use one of two types of keyboard throttle control: incremental and
absolute.

Incremental keyboard throttle: The game uses repeating characters
(like + and -) for acceleration and deceleration. If your game uses this type of
throttle control, you can assign the “increase throttle” and “decrease throttle”
commands to the Plus and Minus buttons on the joystick’s base.

Absolute keyboard throttle: The game uses sequential keys (e.g., 1 2 3
4 5...9) for acceleration and deceleration. If your game uses this type of
throttle control, use the keyboard.
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Enable Elevator Trim

Check this box to enable the elevator trim adjuster on Firebird 2. The trim
adjuster is the wheel to the left of the throttle on the joystick’s base.

Pacing

Some games may be unable to handle incoming keys fast enough, so they may
miss keys, especially when you have a string of keys assigned to a single
button press or release. Drag this slider to the left to increase the delay be-
tween keys. The longest possible delay is 1/4 second. Drag the slider right to
reduce the delay; use the least delay that the game can handle without missing
keys. This slider affects every button that has Delay On checked in the Pacing
field of its function assignment window.
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Base Menu
Use these menu options to assign keyboard or joystick command functions to
the buttons on the joystick’s base.

Follow the instructions in the section on The Add Function Window (at the
beginning of this chapter) for defining button functions.

The Plus and Minus Buttons

You can assign functions to these buttons the same way you would any other
button, but you may find these buttons especially useful for “increase throttle”
and “decrease throttle” commands in games that support only incremental
keyboard throttle control. Please see the previous section, Enable Throttle
Control. These buttons are also good for looking up and down in first-person
perspective games such as Descent ™ .
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Stick Menu
Triggers 1 through 4...
Use these options to assign keyboard or joystick commands to the triggers on
the stick.

The default setting is for compatibility with the Gravis Thunderbird 2/ CH
FLIGHTSTICK PRO: 4-button support using the handle triggers, FLIGHTSTICK
PRO-compatible hat switch, throttle enabled; trim disabled.

Follow the instructions in the section on The Add Function Window (at the
beginning of this chapter) for defining button functions.

Hat Switch Buttons 1 through 8...
You can assign keys or joystick buttons to each of the hat switch directions the
same way that you assign them to any button.

Follow the instructions in the section on The Add Function Window (at the
beginning of this chapter) for defining button functions.

Or, even easier, you can click the “CH” button in the Button Mode field of the
programming window: this automatically assigns the correct commands to the
hat switch controls for CH FLIGHTSTICK PRO hat switch compatibility. You have
to select the CH button only once: it configures all directions of the hat switch
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...Stick Menu, cont'd.
automatically in one step.

If you use the CH button, select “CH FLIGHTSTICK PRO”—not regular
“Joystick”—in the game’s Setup.

In CH mode, if you press the hat switch and a button that is config-
ured as a joystick button at the same time, you will get unpredictable
results. This is a limitation in the CH hat switch control standards.

If a game has keyboard commands for view controls, you will get
better results by assigning those keys to the hat switch and selecting
“Joystick” control in the game than by using CH mode.
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Diagnostics Menu
The tests in the Diagnostics menu are designed to help you identify problems
with your Firebird 2 hardware and connections.

If your joysick is not properly connected, all the diagnostics tests will
respond with appropriate configuration errors.

Firebird Self Test
The Firebird Self Test checks the joystick’s connections and memory. To start the
Firebird Self Test:

Select Firebird Self Test from the Diagnostics menu.

When the test is complete, you will receive one of two messages: ‘Firebird
passed self test’ or ‘Error in self test diagnostic.’ Select Troubleshooting–Error
Messages from the Control Console’s Help for an explanation of the Firebird’s
system messages.

Button Test
Checks that the buttons on Firebird 2 are operating properly.

1. Select Button Test... from the Diagnostics menu.
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...Diagnostics Menu, cont'd.
The Button Test will overwrite the current configuration you have set for
Firebird 2. After the test is complete, you will have to reconfigure
Firebird 2.

A warning appears on the screen: “This diagnostic needs to overwrite the
current Firebird configuration.”

2. Select Yes to continue.

3. When the Button Diagnostic window prompts you, press each button, one
at a time until you have pressed every button on the Firebird. The buttons
on the screen image turn yellow when you press the corresponding joystick
buttons and red when you release them.

4. Select Close Diagnostic after you have pressed all the buttons.

When the Button Test is complete, a test report details any errors it may have
found.

If there is a problem with your joystick buttons, you will receive a message
saying that an error was detected in the button diagnostic. Select Troubleshoot-
ing– Error Messages from the Control Console’s Help for an explanation.

This test is not supported if you are running the Firebird Control Console under
OS/2.
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...Diagnostics Menu, cont'd.
Axes Test
Checks that the joystick and throttle are functioning correctly. The Axes Test
includes several visual aids to help you recognize the center positions of your
joystick and throttle and to help you understand the position information sent to
your computer as you move them.

1. Select Axes Test... from the Diagnostics menu.

The Axes Test will overwrite the current configuration you have set for
Firebird 2. After the test is complete, you will have to reconfigure
Firebird 2.

A warning appears on the screen: “This diagnostic needs to overwrite the
current Firebird configuration.”

2. Select Yes to continue.

3. When prompted, center the trim control and move the stick around 360
degrees. Push the throttle all the way forward, then pull it all the way
back.

4. Select OK or press <Enter>.

The Axes Test window opens.
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...Diagnostics Menu, cont'd.

     
Axes Test Window

5. Push the throttle all the way forward and back. Notice the red indicator
moving on the screen.

For advanced users, x- and y-axis position data is available. Press <Alt-
D> to view the data. The actual analog values depend on the speed of
your game port and computer.

6. Move the joystick along its full x-axis and along its full y-axis. Notice the
position indicator moving on the screen.
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6. When you are finished, press OK or <Enter>.

If you receive an error message during the Axes Test, select Troubleshooting–
Error Messages from the Control Console’s Help for an explanation of the error
messages.

This test is not supported if you are running the Firebird Control Console under
OS/2.



Chapter Topics

Book Topics

Firebird 2 User's Guide

Chapter 3 – Firebird Control Console

Options Menu
The Options menu defines global preferences for the Firebird Control Console.

Image to the Left/Center/Right

Choose one of these options to display the Firebird 2 image on the left, center,
or right of the screen. You can also drag the image around while holding
down the right mouse button.

Show Memory Meter

Check this option to display the memory meter.

      Memory Meter

Firebird 2 has 107 bytes of memory to hold set information. As you add
functions to buttons, you’ll see the needle move towards the F (full) mark. If you
remove functions from buttons, the needle slides back down towards E (empty).
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...Options Menu, cont'd.
Show Function List

Check this option to show or hide the Button Function List.

Sound

Check this option to turn sound on or off in the Console.



Chapter Topics

Book Topics

Firebird 2 User's Guide

Chapter 3 – Firebird Control Console

Help Menu
Help

Select Help from the Help menu to access on-line help.

       

The Help Window includes simple tools to help you find the information you
need. The Table of Contents lets you choose from a list of topics. Select a topic
by clicking on it with your mouse, or use your <Tab> and <Shift-Tab> keys to
move the cursor to a topic and press <Enter> to select it.
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...Help Menu, cont'd.
Use the Contents button to return to the Table of Contents.

Use the Back button to return to the last screen you viewed.

Use the >> button to page forward one screen.

Use the << button to page backward one screen.

Click on the green, underlined text to view a related topic.

About...

Select About... to determine the version of Firebird 2 software and firmware
you have before you call Technical Support for help.
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Firebird Set Loader (FBD.EXE)

You can use FBD.EXE to configure Firebird 2 from the DOS prompt. You do not
have to activate the Control Console every time you want to reset Firebird 2 for
a different game.

1. From any directory, type: FBD [SETNAME] <Enter>.

If your Firebird 2 directory is not listed in your PATH statement,
you will have to change to the Firebird 2 directory before you run
this program.

The FBD.EXE program configures Firebird 2 with the control settings in the
set called SETNAME.FBD.

2. Start your game as usual.

FBD.EXE is especially useful with batch files. You can create a batch file to
configure Firebird 2 and start a game:

1. In a DOS text editor, type: Example:

FBD [Set Name (without .FBD extension)] FBD SETNAME

[Game Drive:] C: CD \[Game Directory ]

CD\GAMEDIR [Game Start Command] STARTGAME

Chapter 4
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2. Save the batch file, and choose a name for it (e.g., PLAYGAME.BAT).

Choose a descriptive name for the batch file, but do not use the same
name used in the command to start the game. Otherwise, the game may
run before the .BAT command, and Firebird 2 will not be configured
properly.

This sample batch file will configure Firebird 2 with the settings in a set
called SETNAME, change the directory to GAMEDIR, and start the game.

To run the batch file, from the DOS prompt:

3. Type: PLAYGAME <Enter>.

Read more about batch files in your DOS manual or DOS Help.
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Firebird 2 KeyTester (KEYTEST.EXE)

You can use the simple, DOS-based Firebird 2 KeyTester program to test your
joystick’s button settings.

1. Start KeyTester. From any directory, type: KEYTEST <Enter>.

If your Firebird 2 directory is not listed in your PATH state-
ment, you will have to change to the Firebird directory
before you run this program.

The KeyTester window opens, displaying a computer keyboard.

2. To test your joystick’s button settings, press each button, one at a time, and
watch the keyboard image to see which key is highlighted or, in the case
of keystroke strings, which keys appear in the status line.

When you press a button set up as a joystick button, the KeyTester display
should show that the joystick button is “down.” When you release the
button, the KeyTester screen shows that the joystick button is “up.”

Use this program to verify that your settings are mapped correctly to the
joystick buttons and that Firebird 2 sends the correct commands to your
games.

Chapter 5
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Joystick Tension Adjustment

You can adjust the tension of the Firebird 2 stick to achieve the perfect “feel”
for your style of control.

Firebird 2 has four separate adjusters to control the stick’s tension as you move
the joystick forward, back, right, and left.

To adjust the tension:

1. Turn the joystick upside down.

2. Notice the slider bars on the base of the joystick (see diagram). Each slider
is labeled from 1 (lowest tension setting) to 6 (highest setting). To change
the tension settings, slide each bar to the setting you prefer.

For consistent response, we recommend that you choose the same setting
across each axis. That is, set the right and left tension adjusters to the same
setting, and set the forward and back adjusters to the same setting.

Square Corners for Calibration

Although most game players prefer a round joystick movement over sticks with
defined corners, some games require the player to move the joystick handle to
opposing corners when calibrating the software to the joystick.

Chapter 6
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Firebird 2 provides round movement without corners in tension settings 1–5.
Tension setting 6 provides defined corners for software calibration and for
those players who prefer corners. If your game’s calibration program requires
square corners, set the joystick’s tension adjusters to setting 6. When you finish
calibrating the game, readjust the tension to your preference.
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Troubleshooting

Introduction

Controls are Erratic or Don’t Work

Game Character Drifts

Keyboard Error or Keyboard Doesn’t Work

Buttons Perform Wrong Commands

Firebird 2 Not Detected or Configuration Errors

Note on Joystick Calibration

Chapter 7
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Introduction
This chapter addresses the most common questions and problems that
Firebird 2 users may encounter.

If you do not find the answer to your question in this section, please select
Troubleshooting from the Firebird Control Console’s Help system for more
detailed help.

If you do not find a solution in this troubleshooting guide or in the Control
Console’s Help system, please look at Chapter 8 for Technical Support informa-
tion.
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Why do the joystick and button controls behave erratically? Or
why don’t the controls work at all?

Run the Diagnostics tests in the Control Console first to check for hardware
problems. See the instructions in Chapter 3 for running Firebird 2 Diagnostics.

If your joystick tests OK or works fine in other games, the problem is usually
not with Firebird 2 itself. There are several other possible causes for this kind of
problem:

1. Your joystick may not be enabled, or your game’s joystick calibration settings may be
incorrect. In many games, you must select or turn on joystick support.

Follow the game’s joystick calibration instructions carefully. Some games have
a specific procedure to make the game recognize a joystick (e.g., pressing
<ALT-J>). Check the game’s instructions. Select the topic Calibration from the
Control Console’s Help for more information on joystick and software calibra-
tion.

2. Another device in your computer may be using the game port’s address.

All game ports use a common address (201 Hex). A joystick will not work
properly if more than one device is using that address (e.g., other game ports,
scanner cards, light pen cards, etc.).

Note: If buttons defined as
keyboard commands work, but
buttons defined as joystick
buttons (and possibly the stick
and throttle controls as well) do
not work properly, the problem
is likely with your game port.
Check the joystick’s connection
to the game port, and make
sure that the game port is fully
functional and that it is the only
active game port in your
system. Read through these
problems and solutions for
more details.
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To determine whether another device in your computer is conflicting with your
game port:

Change to your Firebird 2 directory and type: HELPME <Enter> Follow the
instructions on screen.

If you find a conflicting device in your system, you must disable it or change its
address to avoid problems with the Firebird 2. See the conflicting card’s
manual for information on disabling its game port or changing its address.

Some multifunction cards have game card circuits but no external joystick
connector. In these cases, it is the interface circuit that causes problems, so it is
possible to have a conflict without having another visible joystick connector.

3. Your game may not support a joystick.

Some games are not designed to work with a joystick. Check the game’s
instructions.

4. Your game port may not be fully IBM PC-compatible.

Firebird 2 is designed to connect directly to a game port. It may not work with
some serial or parallel port adapters that are not fully compatible with IBM PC
game ports.

...Controls Are Erratic or Don’t Work, cont’d.
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5. Your CPU speed could be too fast for your software and game card.

Some games and game cards provide inadequate joystick support for faster
computers. Try using your computer in non-Turbo mode (if your computer has
a Turbo mode). If this doesn’t solve the problem, try a speed-compensating
game card.

...Controls Are Erratic or Don’t Work, cont’d.
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Why does my aircraft, ship, or game character drift?
1. Your game’s calibration settings may be incorrect.

See your game’s manual for instructions on calibration. Select the topic
Calibration from the Control Console’s Help for more information on joystick
and software calibration.

2. Your game card’s speed setting may be incorrect.

If you have a speed-compensating game card, and your game port speed has
changed for some reason – or you changed the speed setting for a specific
game – your speed adjustment setting may be incorrect. Adjust the speed
adjustment knob (if there is one) or run the speed adjustment program that
came with your game card or with your game port-equipped sound card. Then
run the game’s joystick calibration program.

3. Another device may be conflicting with your game port.

Follow the instructions for Solution 2 in the previous section.

4. If you’re running a DOS game in a Windows 95 DOS box:

Win 95 puts itself between the joystick and the game software, so it may
interfere with the joystick calibration of a game that is written to access joystick
readings directly.
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Why do I get a Keyboard Error? Why doesn’t my keyboard
work?

You may have the keyboard connector plugged in, but the game port connec-
tor unplugged. If this is the case, your computer cannot send power to the
joystick, and as a result, your keyboard – because it is connected through
Firebird 2 – will not work.

To solve this problem, plug in your game port connector, and check all your
connections. See Figure 1-1 in Chapter 1.
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Why do I get the message “Firebird Not Detected,” even
though some of the  controls work?

You may have your game port connector plugged in, but your keyboard
connector unplugged. Or your keyboard port may not be working correctly or
may not be AT- or PS/2-compatible.

Some of the joystick controls work through the keyboard port. If your joystick,
throttle, and joystick buttons are working correctly, but buttons defined as
keystrokes do not work at all, you have a problem with the keyboard connec-
tion.

If this is your situation, make sure that you plug in your keyboard port connec-
tor, and check all the connections. See the illustration in Chapter 1.

Firebird 2 requires an AT-compatible or PS/2-type keyboard port. It is not
compatible with most computers that have only a built-in keyboard.

Make sure that the AT or ISA bus speed is set correctly in your computer’s BIOS
setup. It must be set as close to 8 MHz as your setup will allow. Look in your
computer’s manual for instructions, or consult the computer’s manufacturer or
your dealer to assist you.
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Why do the Firebird 2 buttons perform the wrong commands
when I press them?

You may be experiencing one of these problems:

1. You may be running a memory-resident program that remaps the keyboard.

If you are running a Terminate-and-Stay-Resident (TSR) program that remaps
the keyboard, Firebird 2 may not perform the functions you assigned to it.
Firebird 2 sends commands through your keyboard and relies on standard
keyboard mapping to perform button functions.

Before using Firebird 2, remove any TSRs that remap the keyboard from
memory. (The MS-DOS alternate language keyboard mappings don’t cause
problems for the Firebird.)

2. You may not have the correct control set loaded.

Find the correct set for the game you want to play, and load it using FBD.EXE
or the Control Console. Check the set using KEYTEST.EXE.

3. Your game may be unable to handle incoming keystrokes fast enough.

Some games may miss keystrokes sent at the joystick's usual high speed. If,
with some games, Firebird 2 appears to sporadically miss some or all key-
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strokes defined for certain buttons, check the Delay On checkbox in the Pacing
field of the function assignment window for those buttons. Then adjust the
Pacing delay slider in the Edit/Preferences dialog (see Chapter 3). This causes
Firebird 2 to delay between keystrokes when sending commands to the game.

You can use the KEYTEST.EXE program to check the configuration of your
joystick’s buttons.

...Buttons Perform Wrong Commands, cont’d.
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Why do I get the message “Firebird Not Detected,” even
though it is connected correctly? Or why do I get an error mes-
sage when I attempt to configure the Firebird?

Some uncommon keyboard BIOS controllers cause a communication problem
between the joystick and computer through your keyboard. To solve the
problem, try using a /k or -k switch when you run the FCC.EXE and FBD.EXE
programs:

Type FCC /k at the DOS prompt to activate the Control Console.

Type FBD /k [setname] to configure Firebird 2 from the command line.
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Calibration—Fact & Fable
Joystick calibration is often misunderstood. The electromechanical calibration
of a joystick aligns the joystick’s mechanical center with the electrical center of
its potentiometers. With good quality, and electrically matched pots, this is a
one-time process that will not change for the life of that joystick or its compo-
nents. For this reason, Firebird 2 does not require external calibration adjust-
ment (through screws or other methods).

The calibration process performed at the start of many games generally
indicates that it is a “joystick calibration.” This poor wording leads game
players to believe that the joystick is being calibrated to the game when, in
fact, it is the software that is calibrated to the joystick. This process determines
the electrical center of the joystick and adjusts the software’s joystick readings
accordingly.



Chapter Topics

Book Topics

Firebird 2 User’s Guide

Chapter 8 – Technical Support

Technical Support Instructions

Support by Telephone

Support by Electronic Mail

Chapter 8

Technical Support

Click on a Topic or click on
the arrow at the bottom of
the page to continue reading
through the book.



Chapter Topics

Book Topics

Firebird 2 User’s Guide

Chapter 8 – Technical Support

Technical Support Instructions
Technical support is available to all registered owners of Gravis products.
Before you call, please read the README file on the software disk. There is no
charge for technical support, except possible long distance charges.

Technical Support Tips
• If only certain programs are affected, read their manuals for information

relating to joysticks and game cards.

• Call from a phone where you have access to your computer so you can
test suggestions and provide any additional information that may be
required.

• Please be prepared to provide the following information:

Name, address and telephone number
The name of the Gravis product
Make and Model of your computer
Your system software and version
Symptoms of the problem, and what led to them
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Support By Telephone
Technical support is available by telephone Monday–Friday 9 a.m.–6:00 p.m.
E.S.T.

In the United States, Canada, and Mexico, please call:

Phone: (610) 266-9505 Fax: (610) 231-1022

In Europe, please call one of these numbers:

Austria 0660-5791 UK 0800-894383
Belgium 0800-16778 Netherlands 0800-0222-694
Denmark 800-17838 Norway 800-11335
Finland 9800-13228 Spain 900-993129
France 05-906053 Sweden 020-795845
Germany 0130-810654 Switzerland 155-8605
Hungary 00800-11727

If your country is not listed, please call either (610) 266-9505 (US) or
0800-0222-694 (Netherlands).

If telephone support is not convenient, we welcome questions sent via fax or
e-mail.
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Support By Electronic Mail
Contact Gravis at the following addresses:

Internet Web Site: http://www.gravis.com

Internet E-mail: pcstick@gravis.com (Canada)

gravis@euronet.nl (Europe)

Internet File Server: ftp.gravis.com

This Web Site is the hub of Gravis‘
online support network. For the
most current and detailed
information and files, look here.
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License Agreement
Advanced Gravis Computer Technology Ltd. (hereinafter referred to as
GRAVIS) thanks you for choosing one of our products for your computer. This
is the GRAVIS license contract that describes GRAVIS’ licensing terms.

SCOPE OF USE: In this Agreement, “software” shall mean all machine read-
able software programs and associated files in this package and any modified
version, upgrades, and other copies of such programs and files. You may use
the software on a single central processing unit. You may not rent it, lend it,
lease it, nor use it on a multi-user system.

LICENSE: You have the non-exclusive right to use the enclosed software. You
are not permitted to use, copy, modify, or transfer the software or documenta-
tion, or any copy or translation, except as expressly stipulated herein. You may
not reverse engineer, decompile, disassemble, or otherwise reduce the soft-
ware to any human perceivable form. The software is owned by GRAVIS or its
licensors and is protected by copyright laws and international treaties.

USE AND RESTRICTIONS: You are permitted to make backup copies of all
disks for archival purposes only. You must reproduce the proprietary notices
and affix them to all backup copies. You are permitted to transfer this license
and product only if the transferee agrees to the terms and conditions of this
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agreement and also completes and returns the registration card to GRAVIS. If
you transfer the software, you must cease using the software, and you must
also transfer, at the same time, all backup copies and documentation. Alterna-
tively, you are permitted to transfer the documentation and destroy all backup
copies. You are not permitted to use the software as a computer service
business, nor to rent or lease these rights to others.

TERM: This license is granted only if all conditions here stated are agreed to by
you, and is effective until terminated. This license is automatically terminated if
you fail to comply with any of the conditions set out in this agreement. You
agree that upon such termination, you will immediately destroy all programs,
copies, and documentation contained herein.

LIMITED WARRANTY: These programs are provided as-is, without warranties
of any kind. The entire risk of the results and performance of the program is
borne by you. Should a program prove defective, you, not GRAVIS or its
licensors, dealers, or agents, assume entire liability, cost of repair, correction,
or any payment whatsoever. Furthermore, no warrant or guarantee is made
regarding representations of the use or results of the program in terms of
correctness, accuracy, reliability, or timeliness. You rely on the program at your
own risk.

...License Agreement, cont’d.
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GRAVIS does warrant that these programmed disks are free from defects in
materials and workmanship under normal use for a period of three (3) years
from the date of purchase, as evidenced by a copy of the sales receipt. If your
software is defective, contact Gravis Technical Support to obtain a Return
Authorization Number. The above is the only warranty of any kind.

DISCLAIMER: To the maximum extent permitted by applicable law, GRAVIS
disclaims all other warranties, either express or implied, including, without
limitation, all implied warranties of merchantability and fitness for a particular
purpose, with respect to the software and any accompanying written materials.
To the maximum extent permitted by law, in no event shall GRAVIS or its
licensors be liable for any damages whatsoever, including, without limitation,
damages for loss of business profits, business interruption, loss of business
information, or incidental or consequential damages. Some jurisdictions do not
allow exclusion or limitation of implied warranties or of liability for incidental
damages, so the above limitation or exclusion may not apply to you. This
warranty gives you specific legal rights which vary from jurisdiction to jurisdic-
tion.

This license is governed by the laws prevailing in the State of Washington.

ACKNOWLEDGMENT: You acknowledge that you have read this agreement,

...License Agreement, cont’d.
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understand it, and agree to be bound by these terms. You also agree that this
agreement is the complete and exclusive statement of agreement between
yourself and GRAVIS and supersedes any prior agreements, oral or written,
and any other communications relating to the subject matter of this agreement.

...License Agreement, cont’d.
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Warranty Statement
ADVANCED GRAVIS COMPUTER TECHNOLOGY ("GRAVIS") warrants this
PRODUCT against defects in material and workmanship under normal use and
service for three years from the original date of purchase. GRAVIS, at its
option, shall repair or replace the defective unit covered by this warranty.

Please retain the dated sales receipt as evidence of the date of purchase.  You
will need it for any warranty service.

To obtain warranty service during the warranty period you must:

1) Call Gravis Technical Support at (610) 266-9505.

2) Give a full description of the problem.

3) Get a Return Authorization Number (RA#).

4) Pack the PRODUCT in its original packaging or any other secure box so
that no further damage occurs. Enclose a letter inside the package giving
us your name, address, phone number, RA# and a brief description of the
problem. You must also enclose a copy of the sales receipt.

5) Clearly mark the outside of the package with the RA#. We will not accept
any return without an RA# marked on the outside of the package. Please
send the PRODUCT POSTAGE PREPAID.
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In order to keep this warranty in effect, the product must have been handled
and used as prescribed in the instructions accompanying this warranty. This
warranty does not cover any damage due to accident, misuse, abuse or
negligence. This warranty is valid only if the product is used on the computer
system specified on the product box. Please check product box for details, or
call technical support.

Repair or replacement, as provided under this warranty, is your exclusive
remedy. GRAVIS shall not be liable for any incidental or consequential dam-
ages. Implied warranties of merchantability and fitness for a particular pur-
pose on this product are limited in duration to the duration of this warranty.

Some states do not allow the exclusion or limitation of incidental or consequen-
tial damages, so the above limitation or exclusion may not apply to you. Some
states do not allow limitations on how long an implied warranty lasts, so the
above limitation may not apply to you. This warranty gives you specific legal
rights, and you may also have other rights which vary from state to state.

...Warranty Statement, cont’d.
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This guide is designed to make information easy to find. Read it “cover to
cover” like a book if you like. Use the navigating buttons or the scroll bar to
page through the guide.

To retrace your steps:

Navigating Buttons

forwardto page 1

go backback 1 page

skip to last pageforward 1 page

Scroll Bar

Click the up arrow or
drag the slider up to

move back.

Click the down arrow
or drag the slider down

to move forward.

 Click the Find button to search for a specific topic.

 Click the Bookmarks button to view the complete Contents list.

In the Contents (“Bookmarks”) list, click the triangles to view subtop-
ics, and double-click a topic to skip to that page in the guide.

 Click the Thumbnails button to view small previews of each page.

 Click the Page View button to return to the default view.

 Click the Resize or Zoom buttons to change the
page view size.

Use the Hand tool to move a document page on-screen when it does
not fit within the window. Drag the hand tool in the direction you
want to move the page.

 Use the Text tool to select text to copy.
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